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SECTION 1 - INTRODUCTION 

MeasureMate software provides real time measurement data for Ultrasonic Arrays’ 
Thickness and Bond Measurement Systems in a graphic and data window format. The 
program is designed to run on an IBM compatible computer operating under Windows 
95/98 or Windows NT. Data is presented by panel. The unique data window provides a 
concise summary of press operations to operators. 

This version of Ultrasonic Arrays’ MeasureMate Software incorporates several significant 
changes to earlier versions. Some of these are: 

 Display multiple charts and graphs on screen simultaneously and tile or cascade as 
desired. 

 Support for interfacing with a remote computer over a network for reporting and 
data input functions. 

 Asymmetric alarms. 

 Instantaneous alarms. 

 Shift summary report. 

 Product list report. 

 Bond integrity chart from raw data (Optional Bond Analysis Component). 

 Increase from a maximum of five to seven TMS gauges. 

Individual thickness measurements are gathered from up to seven thickness gauges by the 
host computer at rates of up to 58 samples per second. Up to 200 measurement points 
(each point can represent the average of several individual measurements) are saved for 
each gauge for each panel. 

Data for bond detection are gathered by the host computer from up to 32 gauges sampling 
at up to 62 samples per second. A maximum of 140 measurement points are saved for 
each gauge for each panel. 
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ABOUT THIS MANUAL 

This manual uses text formatting conventions to identify different types of program con-
trol. Boldface is used to indicate MeasureMate or Windows menu names, such as File and 
Start. Underlines are used to indicate options that can be selected from MeasureMate or 
Windows menu, such as Program Settings. Braces are used to represent specific keys on 
the keyboard of the computer, such as <Enter>. Small caps are used to show either Mea-
sureMate or Windows command button choices, such as OK or NEXT. Italics signifies an 
item that should be chosen from either a MeasureMate or a Windows list, such as Shift 1 
or WinRT. 

TECHNICAL SUPPORT 

Questions concerning installation and program setup can be referred to Ultrasonic Arrays 
Technical Support at:  

 Phone 425/481-6611 

 Fax 425/481-4455 

 E-mail engr@ultrasonicarrays.com. 
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SECTION 2 - THE MEASUREMATE ENVIRONMENT 

The following is a layout of the MeasureMate screen.  

 
Title Bar 

Menu Bar 

 
 
 
 
 
 
 
 

Chart Window 

 
 
 
 
 
 
 
 

Data Window 

Status Bar  

TITLE BAR 

The MeasureMate icon appears at the left of the Title Bar. Any mouse click on the Measu-
reMate icon displays a window control menu, allowing the user to Restore, Move, Size, 
Minimize, or Maximize the program window or Exit the program. Immediately to the 
right of the MeasureMate icon, the software name followed by the release number, i.e. 
V7.01 is displayed. 

MENU BAR 

The contents of the menu bar from left to right are as follows: 

 Shift/Product 

 Edit 

 View 

 Run or Pause depending upon the status of gauge communications. 

 Reports 

 Window 

CHART WINDOW 

The Chart Window is where the charts which are provided with MeasureMate are dis-
played. See Section 8, The View Menu, for descriptions of the MeasureMate charts. Mul-
tiple charts can be displayed simultaneously. See Tile and Cascade below. 
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DATA WINDOW 

The Data Window displays data in alpha-numeric format. More than one data window 
may be open at one time, but only one can be on display. When multiple data windows are 
open, the window on display will be determined by the active chart. 

In many cases you may change the information displayed in the data window by pressing a 
specified function key. When this option is available, the bottom of the data window will 
display the current choices and the corresponding function key for each. 

STATUS BAR 

The contents of the Status Bar from left to right are as follows: 

 The current shift. 

 Eight digits representing the eight alarm outputs. A zero (0) in any position indi-
cates an alarm condition for that output; a one (1) in any position indicates no ac-
tive alarms for that output. 

 The current TMS panel number. 

 The current BMS panel number.  

 The name of the current product. 

 Networking status indicator. Network MMI = None indicates that the Network 
I/O Server component is not installed. Network MMI = Active or Network MMI 
= Inactive, depending upon the status of network communications, indicates that 
the Network I/O Server is installed. 

TILE AND CASCADE 

New in release 7.01, Tile and Cascade commands are available under a Windows menu on 
the main menu bar. 

Selecting the Tile command will cause all open charts to be evenly arranged in the Chart 
Window. 

Selecting the Cascade command will cause all open charts will stack in the upper left-hand 
corner of the Chart Window, with the Title Bar of each chart clearly visible. 
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SECTION 3 - USING MEASUREMATE MENUS 

MeasureMate configuration and reporting functions are accessed through pull-down me-
nus. 

ACCESSING MENUS 

When the system is first started, the main menu bar is automatically displayed. Menus may 
be accessed in either of two ways. 

1. Use the mouse to position the cursor on the desired menu and click the left mouse but-
ton. 

2. Use the shortcut key for the desired menu. Shortcut keys are accessed by holding the 
<Alt> key, then simultaneously pressing the underlined letter from the menu name. The 
shorcut keys for the menus are as follows: 

 S:  Shift/Product 

 E:  Edit 

 V:  View 

 R:  Run  

 P:  Pause 

 T:  ReporTs 

 W:  Window 

Once a menu is active, selections can be made in either of two ways. 

1. Use the mouse to highlight the selection and click the left mouse button or press <En-

ter>. 

2. Use the cursor keys to highlight the selection and press <Enter> or click the left mouse 
button. 

ADDITIONAL SHORTCUT KEYS 

Certain keys or key combinations perform special functions within MeasureMate. The key 
functions are listed below. 

<F2> Changes the information displayed in the data window. A line at the 
bottom of the data window prompts as to the information that will 
be shown when  <F2> is hit. Information displayed in the data win-
dow is arranged in a circular manner so that repeatedly hitting <F2> 
will eventually return you to the report where you started. 

<F3> If certain reports are being shown in the data window, this function 
changes the information that is displayed. This key is not always 
available. When it is, a line at the bottom of the data window will 
prompt you as to its use. 
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<Ctrl + Shift + L> For BMS, this sets products so that they will be re-learned. Before 

a product has been selected, <Ctrl + Shift + L> resets all products 

so that they will be learned the next time they are run. After a prod-

uct has been selected, only the selected product will be learned. 

Learning forces the BMS “7” parameter to 255 during the first 50 

panels processed. Use this feature only when you are sure 50 panels 

from the current product will be received before product change. If 

product change occurs before 50 panels are processed, learning re-

starts the next time the product is processed. 

SELECTING AND MOVING BETWEEN OPTIONS 

Most program parameters are set using text boxes, check boxes, or option groups.  

Moving between fields can be done in either of two ways: 

1. Position the cursor in the field by using the mouse and clicking the left mouse button 

in the field box. 

2. Use the <Tab> key on the keyboard to position the cursor in the desired field. 

To enter data in a text box, position the cursor in the box and type. 

To select check box options, click on the box next to the desired item or on the item itself. 

To select an item from an option group, click on the small round button next to the de-
sired item. 

MEASUREMATE MENU TREE 

The MeasureMate menu tree is dependent upon installed options. The complete tree is 
shown below.  

Main Menu Item 

 Main Menu Command 

  Sub-Menu Command 

 

 

Main Menu Command Description 

Shift/Product  

Set Shift Specify shift 

Set Product Specify current product 



 

11 

 

 

Main Menu Item 

 Main Menu Command 

  Sub-Menu Command 

 

 

Main Menu Command Description 

Edit  

Products Add or edit products 

Program Settings Configure program settings 

Alarms Optional; configure alarm outputs 

Diagnostics Access diagnostic tools 

Passwords Change passwords 

Reset Passwords Restore passwords to factory defaults 

Configuration Activate purchased components (for factory use only) 

View  

Thickness Select specific thickness chart for display 

Profile Chart  

Current Trend  

Range Trend  

Panel Weight Trend  

Average Profile  

Composite  

Thickness Data  

Bond Analysis Select specific bond chart for display 

Panel  

Bond Integrity  

Bond Data  

Spreadsheet  

Run/Pause A toggle switch to run or pause gauge communications. 

Reports Select report for printing to screen, disk, or printer 

Product Report  

Shift Report  

Alarm Report  

Opening Range  

Panel Report  

Shift Summary  

Alarm Output Config  

Setup Report  

Product List  

Print Screen  

Window Select between options for window arrangement 

Tile  

Cascade  
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Following is a brief description of each of the main menu choices. 

SHIFT/PRODUCT 

The current shift and product type must specified prior to recording data from the gauges. 
Shift information is saved with data for future analysis. If shift start times have been set 
during program setup, MeasureMate will track the shifts automatically. A product type 
must always be selected to make certain the system knows the desired product parameters. 

To set either current shift or product type, select Shift/Product from the main menu. See 
Section 6, The Shift/Product Menu for more information 

EDIT 

This menu selection provides access to the following functions: 

 Adding or updating product specifications. 

 Configuring MeasureMate software to your environment. 

 Changing passwords or restoring them to factory default settings. 

 Activating special diagnostic functions. 

Configuring MeasureMate software must be done prior to first use and updated any time 
significant changes are made such as a change to the line speed. 

MeasureMate software must have a definition of any product to be run. A definition of 
each product must be first entered and updated if changes are made to the product. 

See Section 4, Installation and Program Configuration for Program and Product setup 
procedures; and Section 7, The Edit Menu, for descriptions of the Edit menu choices. 

VIEW MENU 

Selection of this menu item brings up to the View menu. The View menu allows selection 
of a chart to be displayed on the computer screen. Section 8, The View Menu, provides 
detailed information on this menu choice. 

RUN/PAUSE 

This selection allows for starting and stopping gauge communications. During the time the 
MeasureMate system is in “Pause” mode, no gauge data acquisition takes place, although 
the gauges continue to measure on the factory floor. See Section 9, Pause/Run, for in-
structions on starting and stopping gauge communications. 

NOTE: Pausing the gauges re-initializes the trend and average profile charts. 
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REPORTS 

Various text reports are available for reporting to the computer screen or printer. Select-
ing this menu entry will bring up the Reports menu. See Section 10, The Reports Menu, 
for a description of the reports provided with MeasureMate. 

WINDOW 

The Window menu offers options to Tile or Cascade all open charts. See Tile and Cascade 
under Section 2, The MeasureMate Environment. 



 

14 

 



 

15 

 

SECTION 4 – INSTALLATION AND PROGRAM CONFIGURATION 

UAI strongly recommends that you make a backup copy of the MeasureMate installation 
disks and keep the backup in a secure, off-site location. 

NOTE: MeasureMate must be installed in the “mmate” directory for proper operation. 

MINIMUM HARDWARE CONFIGURATION 

MeasureMate requires the following minimum PC configuration for proper operation. 

 300 MHz Pentium II 

 64 MB Memory 

 3.2 GB Hard Disk Drive with 1 GB free disk space 

 1.44 MB Floppy Disk Drive 

 8 MB SVGA Card 

 2 Serial Ports 

 Third Serial Port for Weigh Scale option 

 1 Parallel Port 

 Keyboard  

 Mouse or other pointing device 

 Network Interface Card for Network Server option  

 Windows 95/98 or NT Workstation 4.0  

 17 SVGA Color Monitor 

 Host Data Communications Interface Module with Optically Isolated RS-

232/422 Serial Interfaces 

 RS-422 Junction Box 

 

WINDOWS 95/98 INSTALLATION PROCEDURE 

1. Insert the MeasureMate installation disk, Disk 1, into the computer’s 3.5 floppy 
drive.  

2. Left click on the Windows START button. 

3. Select Run from the Start Menu and enter “a:\setup” into the text box.  

4. Click NEXT. Insert Disk 2 when prompted and click OK. 

5. Click FINISH. 

6. Create a short cut to MeasureMate on the desktop. 



 

16 

 

WINDOWS NT INSTALLATION PROCEDURE 

1. Follow the steps given under the Windows 95/98 Installation Procedure. 

2. Left click on theWindows START button. 

3. Select Run from the Start Menu, enter “c:\mmate\NT.reg” into the text box, and click 
OK. 

4. Windows will display a message box confirming that the registry entries have been 
successfully completed. If no message box appears, contact UAI for technical assis-
tance. 

5. Close all programs and restart the computer. To complete the next steps, you must log 
in with administrative privileges. If you do not have administrative privileges, contact 
your network administrator. 

6. After a successful administrative login, click on the START button and select Settings, 
Control Panel. 

7. Depending on the computer, you will see either a list of devices, or a series of icons. 
Select the item/icon Devices to open the devices dialog box. 

8. Select Serial from the list. 

9. Click STARTUP… and choose Manual. Click OK. 

10. Click the START button. 

11. Select WinRT from the list. 

12. Click the STARTUP… button and choose Automatic. Click OK. 

13. Click the START button. 

14. Click the CLOSE button. 

15. Close all open windows and start MeasureMate by clicking on the “Shortcut to 
mmate.exe” icon previously created on the desktop. 
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PROGRAM CONFIGURATION 

MeasureMate program configuration begins by selecting Program Settings from the Edit 
menu. When Program Settings is selected, you will be prompted to enter a password. The 
default program setup password is “mm.” Enter the password and click OK or press <En-

ter>. The Program Setup Options dialog box appears. Each parameter and command but-
ton that appears in the window is examined below. 

Plot Direction 

Profile, Trend, and BMS Panel charts can run either from left to right or right to left at 
your’s option.  

Units of Measurement 

Data can be displayed and stored in either Metric or English units at your option. 

Display Shading Checkbox 

This feature allows you to select one of two ways to plot profile charts. If Display Shading 
is selected, the area between the target value (center point) and the actual measurement 
will be shaded green (good), yellow (warning), or red (error) depending on the value of 
the measurement. This increasees the visibility of out-of-tolerance measurements. If it is 
not selected, the data will be displayed as a simple plot line. 

Auto Printing Checkbox 

When Auto Print is enabled, MeasureMate automatically prints the screen for each panel 
after it has passed under the thickness gauge. Unless you have a special application which 
requires Auto Print, leave this feature disabled. Printing the screen is time consuming; and 
resource intensive; while the screen is printing, no other reports may be sent to the printer. 

End of Press Enable 

This feature is used to activate a hardware End of Press signal input instead of relying 
solely on “dead reckoning” based on panel count. This feature must be used if the TMS 
and BMS systems are not in the same location.  

NOTE: To use the End of Press Enable, the TMS/BMS Order, or if inserting panels, you 
must provide the PLC logic to relay the signal. 
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BMS Product Widths Differ 

BMS Prod. Widths does not influence the number of channels used to grade product. The 
number channels used is already coded for each product in the BMS Bank data. Selecting 
this option causes MeasureMate to shuffle the channels on display for all products. 

BMS channels would normally be numbered from one side to the other. Selecting BMS 
Products Width Differ causes a change to the gauge labeling on BMS charts. Wiring to the 
channels must be done so that it matches the order shown on the chart labels. Failure to do 
so will cause the chart to misrepresent readings taken from a panel. 

BMS cannot eliminate low numbered channels and still have higher numbered channels 
operate. When products are differing widths and centered on the line, channels from both 
edges must be eliminated; thus, when BMS Product Widths Differ is selected, channels are 
numbered - and should be wired - from the inside out rather than from one side to the oth-
er. Looking at a chart, the center (or top center for an even number) channel is numbered 
1. Channel 2 is below number 1, channel 3 is above number 1, channel 4 is below number 
2, etc. Numbering proceeds from the inside out, with odd numbered channels on top and 
even numbered channels on the bottom. This way when the high numbered channels are 
removed for narrow panels, channels are removed from both sides of the centered panel. 

NOTE:  Do not use the BMS Product Widths Differ option for BMS if the “Relay Split” 
option is used in BMS (the “U” parameter is <> 0). 

BMS PROM Age 

MeasureMate performs checks on BMS settings. This is done to ensure that MeasureMate 
will run properly with the BMS. MeasureMate can perform the checks only for BMS 
firmware dated after October 21, 1996. This option must be selected for systems with 
PROMs dated prior to October 21, 1996. 

To determine the date of the BMS firmware, locate the EPROM on your BMS controller, 
located near the top center of your main BMS circuit board. It has a silver or white label 
which starts with “ULTRASONIC ARRAYS, INC.” The date will be clearly marked. 

No BMS Air Cal 

Air cal is a self-calibration step that runs during the gap between panels. Air Cal is usually 
disabled for continuous presses and for BMS-5000 installations. Checking this option dis-
ables air cal. This option is not normally changed by the end user. 

BMS/TMS Order 

This option specifies which gauges come first on the line, TMS or BMS. For Measure-
Mate purposes, gauges may be considered to be in the same location if a panel will clear 
the trailing gauges before the next panel reaches the leading gauges. For example, TMS 
gauges are first, but the gauges are close enough together so that a panel will be past the 
BMS gauges before the next panel reaches the TMS gauges. 
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Gauge Labels 

Each gauge can be named for easy on-screen identification. The gauge label default names 
are “Gauge 1” for the first gauge, “Gauge 2” for the second gauge, and so on. Gauge 
names may include any characters and can be up to 15 characters long. 

Shift Setup 

Enter the start time for each shift in the appropriate text box using military notation, i.e., 
1:30 pm equals 13:30. 

If you have fewer than four shifts, leave the extra shift boxes empty. 

Line Speed 

Enter the  approximate speed at which a panel moves down the line. This figure, along 
with board length, is used in calculating how frequently to query the gauges to get the 
proper number of samples per panel. 

This parameter must be set for systems with no tachometer. Values entered should range 
from 50-600 using numeric digits only. 

Samples per Board 

Choosing the number of samples to be taken per board helps MeasureMate run at the op-
timum speed. The goal is to take as many samples per panel as possible without exceeding 
the capacity of the serial port. This figure is influenced by the number of gauges on your 
system. Twice as many readings may be made on a three gauge system as on a 6 gauge 
system. A reasonable number of samples per panel would be from 100 to 140 samples for 
an 8 foot board running at roughly 150 feet per minute. 

This figure is also used to scale profile charts so that the full chart width represents the 
number of samples entered here. 

Board Length 

Entering the length of the board allows the system to calculate how often the gauges must 
be sampled to get the proper number of samples per board. Enter the length of the board 
in whole numbers using feet or meters depending upon the unit of measurement previously 
selected. 
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Pulses per Reading 

This controls the TMS gauge sampling frequency. This method of controlling the sampling 
frequency is available only if an optional tachometer is attached to your system. If no ta-
chometer is attached to your system, Pulses per Reading must be set to zero (0). See Line 
Speed and Board Length above for the alternate method of controlling sampling frequen-
cy. 

This figure is the number of tachometer pulses to be counted between each reading of the 
gauges. The value entered should be a whole number from 0 to 250 using numeric digits 
only. 

Pulses per Reading should be adjusted so that the TMS Profile Chart comes close to the 
right edge of the plot area, but does not quite touch the right edge. If plots do reach the 
right boundary it means that you may be losing readings at the end of the panel. If the plot 
is short, make this number smaller (shorter time between readings); if the plot is too long, 
make this number larger (longer time between readings). You may make a change to this 
parameter and observe the change without exiting Program Settings, but expect a delay 
of a couple of panels after changing this number before seeing the results on the screen. 

Edge Skip 

This applies only to the TMS component of MeasureMate. The first and last few mea-
surements on a panel are be unreliable. Statistics will more closely represent the true con-
dition of a panel if these edge readings are discarded. Use this parameter to set the number 
of readings to ignore at the leading and the trailing edges of the panel. The correct value 
depends on the line speed and gauge positioning and the condition of the panel edges. Set 
this figure to eliminate spurious readings at the leading and trailing edges of the panel. A 
good starting point is 10. 

BMS Learning Normal Speed 

The BMS automatically calibrates itself to the material being run. This is referred to as 
"learning." When new products are run, or after maintenance of the BMS system, learning 
is set to "Fast", in order to quickly adapt the system to the product.  During normal opera-
tions, learning is set to Normal.  This allows the system to gradually adjust to the ex-
pected, small, long-term changes in the product and the measuring system.  A typical value 
for Normal Learn Speed is between 1 and 8.  With a value of 8 for Normal Learn Speed, 
the system can make a small adjustment on each panel.  With a value of 1, several panels 
must pass the system before even a small adjustment is made. 

BMS Learning Number Panels 

This parameter sets the number of panels required for learning when "Fast Learning 
Mode" is selected during product configuration. After the specified number of panels has 
been run without interruption, MeasureMate will return the BMS learning speed to Nor-
mal.  Note that if the product is changed before the number of panels specified by this pa-
rameter has been run, the learning process will start over the next time the product is run. 
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History Autosave Days 

MeasureMate is capable of saving historical data for analysis at a later date. This item con-
trols whether the data will be saved automatically at the end of each shift and at program 
shutdown or on a file by file basis by the operator.  

When Autosave is enabled, historical data is saved automatically and no operator input is 
required. Old history files will be automatically deleted after a specified number of days. If 
it is required that old history files be retained, UAI recommends that they be transferred to 
storage media prior to automatic deletion. 

The data is saved as a set of three matched files. All three files must be present to utilize 
the historical data. 

1. HSTxxxxx.dat File containing the majority of the historical data 
2. HSTxxxxx.idx: An index file pointing to each record in the .dat file 
3. HSTxxxxx.ref: A cross-reference between the product number and the product 

name at the time of the production run 

The variable information in the History file names (represented by x’s in the samples 
above) can be decoded as follows: 

Position 1:  One character to indicate the month. 
1 January 
2 February 
3 March 
4 April 
5 May 
6 June 
7 July 
8 August 
9 September 
O October 
N November 
D December 

Positions 2 and 3: Two digit day of the month 

Position 4:  Shift 

Position 5: Additional character allowing unique file names. This character 
makes it possible to have multiple files for a given shift if, for ex-
ample, MeasureMate is closed and restarted during a shift. The first 
history file for a shift is designated with an “A,” the second with a 
“B,” and so on. 

Autosave is enabled by entering a value other than zero (0) for Autosave Days. The value 
entered also controls the number of days the historical data is retained on the Measure-
Mate PC prior to automatic deletion. 
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A value of zero should be specified if it is not required that MeasureMate automatically 
save the historical data. Instead, at the end of each shift and each time MeasureMate is 
shutdown, the operator will be asked if the history files should be saved. If the operator 
clicks YES, he will be asked to enter a file name. Additionally, the disk will not be scanned 
for old history files to delete.  

Historical data can be imported into most spreadsheet applications for further analysis. See 
Section 14 - Running RPSS for further information. 
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The Port Setup Command Button 

The “Port Setup” Command Button is used to access the Port Setup dialog box. Changes 
made to the port parameters are not implemented immediately. You must exit Measure-
Mate and restart the program before changes take effect.  

CAUTION: It is important to remember that modifying of these parameters may disable 
communications between the MeasureMate computer and other components of your sys-
tem. Before changing any settings in this screen make sure the old settings are available 
for reference by printing a Setup Report. 

To make changes to the Port Setup, click PORT SETUP. 

TMS Port 

Enter the COM number of the TMS gauge port. Com1 is usually used.  

TMS Baudrate 

This parameter controls the baud rate used to communicate between the Measu-
reMate computer and the TMS gauges. The default setting is 9600.  

MeasureMate allows you to increase the rate at which readings are taken as the 
line speed increases. At some point, however, a maximum is reached and the num-
ber of readings taken per panel can no longer be increased. If the line speed is high 
enough, the number of readings per panel may be below a desirable level. Increas-
ing the TMS baud rate increases the maximum frequency at which TMS readings 
may be taken. 

To select a higher baud rate, click on the arrow next to the Baud Rate field. The 
available baud rates will be displayed. 

The higher baud rate is available only on TMS-5000 gauges with firmware ver-
sions ending in 97 or higher. The firmware version can be found on a label on the 
gauge EPROM on the main board. On these versions, the TMS controller will au-
tomatically recognize the baudrate. For upgrades or questions, please contact Ul-
trasonic Arrays.  

BMS Port 

Enter the COM number of the BMS gauge port. Com2 is usually used 

BMS Baudrate 

This is available only on systems with the BMS option included. This parameter 
controls the baud rate used to communicate between the MeasureMate computer 
and the BMS gauges. The default setting is 9600 baud. To change the setting click 
on the arrow next to baud rate and the available baud will be shown. All BMS sys-
tems are capable of operating at 9600 baud. BMS systems that have an EPROM 
with a release greater than BMS6.A21 are capable of operation at either baud rate.  
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In those BMS systems capable of operating at either baud rate, the BMS will 
choose the speed based on a dip switch setting. See the documentation that came 
with your BMS for instruction on changing the dip switch setting. The baud rate 
settings at the BMS controller and in MeasureMate must be the same to establish 
communications. 

BMS #2 Port 

The BMS #2 parameters apply only to BMS systems with more than 16 bond mea-
surement zones. Enter the COM number of the BMS gauge port. 

BMS #2 Baudrate 

This parameter controls the baud rate used to communicate between the Measu-
reMate computer and the BMS gauges. The default setting is 9600 baud. To 
change the setting click on the arrow next to baud rate and the available baud will 
be shown. All BMS systems are capable of operating at 9600 baud. BMS systems 
that have an EPROM with a release greater than BMS6.A21 are capable of opera-
tion at either baud rate. 

In those BMS systems capable of operating at either baud rate, the BMS will 
choose the speed based on a dip switch setting. See the documentation that came 
with your BMS for instruction on changing the dip switch setting. The baud rate 
settings in the BMS machine and in MeasureMate must be the same or communi-
cations will not take place. 

Scale Port 

Enter the COM number of the Scale port. Com3 is usually used. 

Scale Baudrate 

This option is used only if a serial scale is installed with your system. To select the 
scale baud click on the arrow next to baudrate for the available baud. 

Scale Type 

The type of scale used is selected here. The types will be either a parallel scale be-
fore the gauges, parallel scale after the gauges or a serial scale. 

Digital I/O Port 

This is a parallel port for reading or writing the following: 

 Weight measurements from parallel weigh scales 
 End of press 
 Alarm outputs 
 Line moving output 
 BMS panel processed input 
 Insert panel input. 

The port address is entered as a three position hex number and must be 320 (hex).  
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Counter Port 

This is the input for alarm timing or gauge pulse timing for a tachomenter. See the 
tachometer documentation for instructions on setting the I/O address. The counter 
I/O address must not conflict with any other card installed in your computer. The 
address of the counter port is entered as a three position hex number and must be 
328. If no tachometer is used, enter a value of zero (0). 
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The Press Setup Command Button 

Press setup will normally be performed by UAI personnel. To setup or edit this informa-
tion yourself, click PRESS SETUP to display the Press Edit dialog box. 

Press Name 

Enter the commonly used name for the press being configured.  

Number of Openings 

Enter the correct number of openings for the press being configured. For conti-
nuous presses, Number of Openings should equal one (1). 

The Openings Equal Checkbox 

Checking this item simplifies program and product configuration. This item should 
be selected if setup parameters for each product will be the same for each opening. 
If selected, modifications made to one opening will apply to all openings.  

The Edit Openings Command Button 

This applies only to multi-opening presses. 

When all changes have been made click OK to exit and save changes, or CANCEL 
to exit without saving changes.  
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PRODUCT CONFIGURATION 

From the Edit Menu, select “Products.” You will be prompted to enter the a password; 
the default password is “mm.” After password verification, the Product Select dialog box 
appears.  

To add a new product, click Add Product to display the Product Edit dialog box. Enter a 
name for the new product in the Product Label text box.  

SETTING BMS PARAMETERS 

The following parameters must be configured for proper bond monitoring.  

BMS Material Bank Number  

User assigned. Relates to banks of numbers stored in the BMS controller. 

BMS Group Size  

This value controls the number of measurements that are combined into one reading. Set 
this number so that the number of readings is 140 or less per panel. This number can be 
computed by knowing board length and line speed, but the effect of this setting can be ob-
served by looking at the Panel chart in the Bond Analysis sub-menu. If the plot is short, 
this number needs to be made smaller. If the plot frequently hits the right boundary the 
number needs to be made larger. 

BMS Blow Level  

The value below which a transducer reading must be before the reading is considered a 
blow. The valid range includes 0 to 1023. Set based on experience; the suggested starting 
value is 200. 

BMS Blow Size  

Number of samples in a row that must be below the blow level before a blow is indicated. 
The suggested starting value is the number of readings that would occur in four inches. 

BMS Warning Level  

The value below which a transducer reading must be before the reading is considered a 
warning. The valid range is from 0 to 1023. Set this value based on experience; the sug-
gested starting value is 200. 
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BMS Warning Size  

Number of samples in a row that must be below the warning level before a warning is in-
dicated. The suggested starting value is the number of readings that would occur in three 
inches. 

To exit this screen after making changes click on OK. To exit without saving changes, 
click CANCEL or the Windows EXIT button in the top right corner of the dialog box. 

NOTE: BMS parameters may also be configured at the BMS controller. The values will 
then be uploaded to MeasureMate, assuming the material bank number was not changed at 
the controller. 

Fast Learning Mode 

Product learning speed is set automatically for new products. For new products, the learn-
ing speed parameter is set to 255 to force the product to be learned quickly. After a speci-
fied number of panels (number of panels is specified in parameter “BMS Learning Number 
of Panels”), the learning speed is reduced to the normal learning speed. Normal learning 
speed is specified in “BMS Normal Learning Speed.” Suggested values are 50 for number 
of panels to learn and 7 for learning speed. 

While the product is being learned, during the first 50 panels, BMS alarms are suppressed 
by reducing the blow level to 1. This eliminates the possibility that good panels will be 
alarmed while the product is being learned. If the product is changed prior to completion 
of the learning process, learning starts from the beginning the next time the product is 
processed.  

Editing an Existing Product 

To edit an existing product, highlight the product to be edited and click EDIT EXISTING 

PRODUCT to display the Product Edit dialog box. 
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SETTING TMS PARAMETERS 

Narrow Product 

This parameter is found on the Product Edit dialog box and applies only to thickness mon-
itoring systems with five gauges. When Narrow Product is selected, the system automati-
cally stops collecting data from the two outside gauges. Since the center three gauges are 
the active gauges, the product must be centered on the line. 

Target Edit Dialog Box 

To set other thickness parameters, from the Product Edit dialog box, click EDIT OPENINGS 
to display the Target Edit dialog box.  

NOTE:    A warning may appear stating “Editing Targets for the current product will halt 
grading of the current product. You will need to re-select the product and run to resume 
grading. Continue with edit?” If you reply “YES”, gauge communications will be termi-
nated. When you finish editing the product, re-select it and choose Run. 

The Target Edit screen controls configuration of the following parameters. 

Target Value 

Contains the target (desired) thickness. This value is used as the midpoint for the 
Profile chart and certain other charts. 

Plotting Range 

This provides the scale limits used when plotting charts. The value entered is add-
ed to and subtracted from the target value to define the highest and lowest values 
that will be displayed. Measurements that exceed the scale endpoints will not ap-
pear on the charts. 

Upper Warning Level 

The Upper Warning Level value is added to the Target Value to define the point at 
which the plotted data will change from green to yellow in order to signify a warn-
ing condition. 

Lower Warning Level 

The Lower Warning Level value is subtracted from the Target Value to define the 
point at which the plotted data will change from green to yellow in order to signify 
a warning condition. 

Upper Error Level 

The Upper Error Level value is added to the target value to define the point at 
which the plotted data will change from yellow to red in order to signify an error 
condition. The Upper Error Level must be greater than the Upper Warning Level. 
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Lower Error Level 

The Lower Error Level value is subtracted from the Target Value to define the 
point at which the plotted data will change from yellow to red in order to signify 
an error condition. The Lower Error Level must be lower than the Lower Warning 
Level. 

Allowed Std Deviation 

The Allowable Standard Deviation of the thickness from the target thickness. Cal-
culated values of standard deviation which exceed this value can be set to trigger 
an alarm. 

Target Weight (Weight Scale Option) 

Enter the target weight of the panel in either English units (pounds) or Metric units 
(kilograms), depending upon which was selected during Program setup. 

Weight Error 

Enter the allowable variance from the Target Weight before a weight error is to be 
triggered. Use the same units as used for the Target Weight. 

Exiting Product Setup 

To exit Product Setup, after making changes, click OK until all menus have been deacti-
vated. To exit without saving changes, click CANCEL or the EXIT button in the top right 
corner. 
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ALARM CONFIGURATION (ALARMS OPTION) 

MeasureMate can be run without configure the Alarms option, but it is required for paint 
sprayers, audible alarms or other connected devices to work. Alarm outputs can be confi-
gured with MeasureMate running, which can provide feedback as to the appropriateness 
of the settings selected. 

Select Alarms from the EDIT menu. When Alarms is selected, you will be prompted to 
enter a password. The default alarm setup password is “mm.” Enter the password and 
click OK or press <Enter> to display  the Alarm Outputs dialog box.  

Outputs 

Outputs are physical alarms activated if the trigger for that output is fired. If bond alarms 
are to be produced from MeasureMate, Alarm Output1 must be dedicated to the bond 
alarm (no other triggers are permitted), and Trigger1 must be used for the bond alarm. If 
bond alarms are not to be produced, Output 1 is identical to the other outputs.  

Triggers 

Triggers are used to activate a switch to an output when certain conditions are met. Select 
the trigger to be configured by clicking on the arrow button next to the Triggers field and 
highlighting the desired trigger.  

Types 

Refers to the available configuration trigger types. A description of each appears below. 

Density 

The Density Trigger will cause the output to go active whenever the panel density 
is above the maximum value or below the minimum value. In order to use this fea-
ture, the weight scale option must be configured in MeasureMate. Call ultrasonic 
Arrays, Inc. for further details if this feature is desired. 

To select the Density Trigger you must choose either the <Min Density or the 
>Max Density Trigger. 

Selecting either maximum or minimum density will cause MeasureMate to prompt 
you for numeric entry of that parameter. If it is desired to have an output trigger 
on the density be either above the maximum or below the minimum, two triggers 
must be used. 

Avg Thickness 

The Average Thickness Trigger will cause the output to be triggered whenever a 
selected gauge or all of the gauges detect an average thickness for a panel which is 
over or under either the warning or error level. 

Selecting Avg Thickness prompts you to choose a gauge by displaying the Gauge 
field. 
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Select all gauges or a specific gauge. After a gauge has been selected (or all gaug-
es) the Error/Warning Level Triggers box appears prompting you to choose the er-
ror or warning limit. This completes the configuration of the trigger. 

Blow Percent 

This alarm triggers when a user-specified number of panels are blown out a pre-
viously specified sample size. Since sample size may not be 100, the Blow Percent 
does not literally represent a percentage of panels blown, but is the actual number 
of blown panels. This alarm will trigger only if two conditions are true: 

1. The last panel contained a blow. 

2. The number of bad panels in the last “sample size” panels is equal to or ex-
ceeds the specified number. 

Blow Percent may be used on only one output; successive uses of this alarm are 
disallowed. Any output may be used, but it must only trigger for the output. The 
first trigger will be used regardless of the trigger selected.  

The alarm will not be triggered if the last panel is good even though the number of 
bad panels and sample size condition is met. 

When Blow Percent is selected you will be asked to enter the number of blown pa-
nels required to trigger an alarm. The sample size is entered during Program Setup. 
The number of bad panels must be between 1 and 254, and the sample size must be 
between 1 and 256. Additionally the sample size must be greater than the number 
of bad panels specified. 

BMS Shut Off 

The BMS Shut Off Trigger will alert the operator that the BMS System is not 
sending data or has been shut down. 

Bond 

The Bond Trigger forces the first output to go active whenever the Bond Analysis 
system detects a blow or delamination. If a bond alarm is used it must be placed on 
the first output. In addition, it must be the only trigger for that output. Trigger1 
will always be used to store the bond trigger. 

Immed. Profile 

The immediate profile trigger will cause the output to be triggered immediately af-
ter the condition is met rather than waiting until the end of the panel like all other 
triggers. 

Panel Count 

This alarm does not represent an error condition. It was included so that Measu-
reMate can trigger a blow down of the BMS reflectors every so many panels. Pan-
el Count may be used on any output, but it must be the only trigger specified for 
the output on which it is used. The trigger number selected is ignored; the first 
trigger is always used. 
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If Panel Count is selected as a trigger for an output, that output will be triggered 
on the first panel and then every so many panels after that. The interval (in number 
of panels) between output triggers is specified by you. If you specify 50 panels the 
panel numbers 1, 51, 101, 151, and so on will be triggered. The count used to trig-
ger this alarm is not the count that you see on the bottom of the screen, which is 
affected by product changes and press load rejections. The count used is effected 
by neither of those events. It is however reset at shift change. 

Selecting Panel Count prompts you to enter the number of panels between alarms. 
Any number between 1 and 32,767 will be accepted.  

Panel Trend 

The Panel Trend Trigger will cause the output to be active whenever a gauge or all 
of the gauges detect that a number of samples in a row for any panel trending away 
from the target thickness. 

Selecting Panel Trend prompts you to select the desired gauge. 

Once the alarm conditions are met, the output will be turned on immediately and 
stay on until a good panel is graded. The delay and duration coded on the output 
are ignored. 

Profile 

 The Profile Trigger will trigger the output whenever a selected gauge or all of the 
gauges detects a set of thickness samples that are over or under either the warning 
or error level. 

Selecting Profile causes a box to appear which prompts the operator to enter the 
number of samples in a row that must be detected for a trigger condition. Type the 
desired number in using the keyboard. Currently, the number of samples in a row 
that is entered will be tied to the Output. So setting the number of samples for one 
trigger on the output sets the number of samples in a row for all existing triggers 
on the output. Each trigger cannot have a different number. Where different num-
bers of samples in a row are needed, separate outputs should be used and be tied 
together. For example, if the operator wanted to spray a panel when one gauge 
had 8 out of specification samples in a row or when all gauges had 4 bad samples 
in a row, the two separate alarm outputs would be tied together and then be con-
nected to the sprayer. 

Range 

The Range trigger will force the output to go active whenever a selected gauge or 
all of the gauges detect any two readings on a panel whose difference is greater 
than the difference between the warning levels. In other words, if the thickness 
reading minus the thinnest readings for a panel are more than twice the value en-
tered for “WRN LVL” in the Setup Products screen, then the output will be trig-
gered. 

Selecting Range brings up the Gauge Select field. Make the desired gauge selec-
tion. This completes the definition of the trigger. 
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Sigma 

The Sigma trigger will cause the output to be triggered whenever data from a se-
lected gauge or all of the gauges has a standard deviation greater than the limit set 
for that product. The limit for sigma is set during product setup. 

Selecting Sigma causes the Gauge Select field to be displayed. Make the desired 
gauge selection. This completes the definition of the trigger. 

Weight 

In order to use this feature, the weigh scale option must be installed in Measure-
Mate. Call Ultrasonic Arrays, Inc. for further details if this feature is desired. 

This feature uses the target weight and weight error threshold information entered 
into the product update screen. 

When Weight is selected, the Error/Warning Level Trigger box is displayed on 
screen prompting you to choose the error level. 

Delay 

This is the amount of time to wait after the end of the panel has passed under the gauges 
before turning on the alarm. Delay can be measured in either seconds or pulses.  

Delay in Pulses 

Use this option only if a tachometer is used. After selecting this item you will enter 
the number of pulses to delay the activiation of this alarm output after the alarm is 
triggered. The number entered may range from 0 to 2,000,000,000. 

Delay in Seconds 

This option is used when the line is operated at a fairly constant speed and no ta-
chometer is installed. After selecting this item you will enter the number of seconds 
the systems uses to delay the alarm output after it is triggered. The number entered 
can range from 0 to 65 seconds. 

Dwell 

This is the amount of time to leave the alarm on once activated. Dwell can be measured in 
either seconds or pulses. 

Dwell in Pulses 

Use this option only if a tachometer is used. After selecting this item you will enter 
the number of pulses to keep the activated output on. The number can range from 
0 to 2,000,000,000. 

Dwell in Seconds 

This option is used when no tachometer is installed. After selecting this item you 
will enter the number of seconds the system will maintain the alarm output once 
activated. The number entered can range from 0 to 65 seconds. 
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Gauges 

This field is used to select the gauge to be used for the trigger. Gauge selection is used 
with the following trigger types: 

 Avg. Thickness 

 Immed. Profile 

 Panel Trend 

 Profile 

 Range 

 Sigma 

Selecting the gauges is one of the final steps in defining the trigger. 

Error/Warning Level Triggers 

Several of the trigger types require you to select a limit level. If this is required the Er-
ror/Warning Level Triggers box will appear prompting you to select the desired limit. 

>Warning Level 

 Selecting this option will cause the output to be triggered whenever the specified 
measurements are above the maximum warning level the required number of times 
in row. 

<Warning Level 

 Selecting this option will cause the output to be triggered whenever the specified 
measurements are below the minimum warning level the required number of times 
in row. 

>Error Level 

 Selecting this option will cause the output to be triggered whenever the specified 
measurements are above the maximum error level the required number of times in 
a row. 

<Error Level 

 Selecting this option will cause the output to be triggered whenever the specificied 
measurements are below the minimum error level the required number of times in a 
row. 
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PRINTING MEASUREMATE CONFIGURATION REPORTS 

Make sure your printer is connected and on-line. From the Reports menu, select Setup 

Report. A dialog box will appear for printing to screen, printer, or disk. Enter a “p” from 
the keyboard (for printer) and press <Enter>. 

That report lists the configured during Program Setup. 

Next select Alarm OutpConfig Rpt from the Reports menu. A dialog box will appear for 
printing to screen, printer, or disk. Enter a “p” from the keyboard (for printer) and press 
<Enter>. 

Store the reports in the labeled pockets provided at the back of this manual for future ref-
erence. 

INITIAL SETUP COMPLETED 

This completes the special steps necessary for first time startup. Return to the Menu Bar. 
You are now ready to proceed with running MeasureMate. 

CONTROLLING GAUGE COMMUNICATIONS 

Select SHIFT/PRODUCT from the Menu Bar. 

If shift start times have not been entered, position the pointer on Set Shift to highlight and 
bring up the shift choices.  

Highlight the desired shift and click on the left mouse button. This selects the shift and 
immediately brings up the product selection window.  

Select the desired product from the Product Select menu by highlighting the product and 
clicking OK or pressing <Enter>.  

From the menu bar, click RUN. 

MeasureMate Software is now running. 

EXITING MEASUREMATE  

To exit MeasureMate, click on the exit icon in the upper right corner. The system will ask 
you for a password to exit enter “mm” and click OK or press <Enter>. 
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SECTION 5 - MEASUREMATE COMPONENTS AND OPTIONS 

MeasureMate software may be configured with either or both of two major components 
which are used to monitor Ultrasonic Arrays gauging systems. 

1. Thickness Monitoring Component, for use with TMS-Series Thickness Measure-

ment Systems 

2. Bond Analysis Component, for use with BMS-Series Bond Measurement Systems 

THICKNESS MONITORING COMPONENT OVERVIEW 

The Thickness Monitoring Component collects data from TMS-Series Thickness Measur-
ing Systems. Data is collected for up to 200 points along the length and up to seven zones 
across  each panel. Real time displays make thickness variations immediately apparent. 
Charting and reporting options are available to help the operator identify problems. Op-
tional alarm outputs can be connected to paint sprayers, bells, or lights and be set to trig-
ger when errors occur. 

BOND ANALYSIS COMPONENT OVERVIEW 

The Bond Analysis Component collects date from BMS-Series Bond Measuring Systems. 
Data is collected for up to 140 readings taken along a panel by up to 32 transducer pairs 
ranged across the panel. Defects detected by the gauges can be immediately displayed to 
the Operator. Optional alarm outputs can trigger a bell, light or ink marking system. BMS 
defect detection is supported by a comprehensive reporting system that helps the Operator 
identify trends and errors in press setup. 

HISTORY OVERVIEW 

The History Component allows saves production readings automatically at the end of each 
shift or at program shutdown. The data may be used to create a printed report or it can be 
converted to a format which may be loaded by most spreadsheet applications. Possible 
uses of saved history data include problem analysis, trend analysis and shift statistics. 

CHARTS OVERVIEW 

MeasureMate offers a variety of on-screen charting capabilities, allowing you to view cur-
rent data. 

REPORTS OVERVIEW 

MeasureMate offers a variety of reports that can be displayed on-screen, saved to disk, or 
printed allowing further analysis of current data. 
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ENCODER INPUT OVERVIEW 

Encoder (or tachometer) input is used to control reading frequencies. A tachometer is is 
provided as standard equipment with BMS-Series Bond Measuring Systems. Measure-
Mate’s Encoder Input feature uses pulses to measure the panel more consistently and is 
recommended if line speed varies. 

ALARMS OPTION OVERVIEW 

MeasureMate software supports up to eight separate alarm outputs. These are used to 
alert manufacturing personnel when product is of out of specification. Each alarm output 
can be independently configured with a delay before it becomes active; and dwell, or dura-
tion of activity, after a trigger occurs. The delay and dwell times can be defined in seconds 
or tachometer pulses. 

WEIGH SCALE OPTION OVERVIEW 

The Weigh Scale option allows a scale to be connected to the computer so that the weight 
of each panel can be read by MeasureMate software. This allows MeasureMate to check 
for errors based on weight (or density) and to report panel density in its various reporting 
and alarm functions. 

NETWORK I/O SERVER OPTION OVERVIEW 

The Network Server option allows access to current data Net DDE or OPC interfaces 
from any computer connected to the network. Users can access any of the defined Tag 
Names from their WonderWare, Intellution, Rockwell Automation, or other Net DDE or 
OPC aware software. In addition, users can access the data using custom programs writ-
ten in Visual Basic, Visual C, or even Microsoft Excel. Multiple users can access the same 
data. 

See Appendix H for a list of MeasureMate Tag Names. 
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SECTION 6 – THE SHIFT/PRODUCT MENU 

The shift and product must be selected upon program startup, prior to starting gauge 

communications. 

SET SHIFT 

If  shift start times were entered during program configuration, MeasureMate will deter-
mine the shift for you. 

If shift start times have not been previously specified, the shift must be specified upon 
starting MeasureMate software and again at each shift change. Not only is this necessary 
for reporting purposes, but MeasureMate software stores considerable data for the current 
shift. Setting the correct shift at shift change is required by MeasureMate software to keep 
the amount of storage space reauired for that data within reasonable bounds. 

To set the current shift, select Set Shift from the Shift/Product menu. Select the desired 
shift. The Set Product window will open automatically. 

SET PRODUCT 

Highlight this menu item and press <Enter> to display the Product Select dialog box.  

The Available Products list box contains a listing of all products previously entered. High-
light and click the mouse button on the name of the product to be run and click <OK> or 
press <Enter> to select the product.  

To add or edit products, see Section 3. 

Once a product has been selected, you are returned to the Menu Bar. 
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SECTION 7 – THE EDIT MENU 

PRODUCTS 

This password protected menu item should be selected for product setup. To add or edit 
products, see Section 4, Installation and Program Configuration. 

PROGRAM SETTINGS 

This menu selection allows configuration of MeasureMate software to your environment. 
Some configuration options are: 

 Parameters to configure MeasureMate to your computer such as specifying ports 

and drives. 

 Parameters to configure MeasureMate to your production hardware such as line 

speed or gauges on-line. 

 Parameters to configure MeasureMate to your product such as panel length or 

board area. 

 Parameters to configure MeasureMate to your reporting preferences such as shad-

ing and gauge names. 

 Changing Passwords. 

Program Setup parameters should be reviewed every time there is a change to computer 
hardware or to the MeasureMate operating environment. 

This menu item is password protected. To edit Program Settings, refer to Program Confi-
guration in Section 4, Installation and Program Configuration. 

ALARMS 

This item is used to edit alarms for TMS and BMS. This menu item is password protected. 

For alarms editing procedure, refer to Alarms Configuration in Section 4, Installation and 

Program Configuration. 

DIAGNOSTICS 

Diagnostic aids are included for verifying and troubleshooting operation of the gauges.  

SET PASSWORDS 

Choose this menu item to change passwords. The Product Edit/Program Exit, Program 
Setup, and Diagnostics passwords may be changed. The initial password for Product Edit/ 
Program Exit and for Program Setup is “mm.” Passwords may be up to 15 characters. 

Select the password to be changed. 
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When the password has been selected, you will be asked to enter the old password. Enter 
the old password followed by <Enter>. If you correctly entered the old password, you will 
be asked to enter a new password. Enter the new password followed by <Enter>. <Back-

space> characters are valid characters in a password, so they cannot be used to back over 
mistakes.  

After you have entered the new password for the first time, you will be asked to enter it 
again for verification. This precludes the possibility of locking yourself because of a typing 
error. If your attempt to change the password fails, you will be repeatedly asked to enter a 
new password and then to verify it until you have entered and successfully verified a new 
password. 

After the new password has been entered and verified, the system will display a confirma-
tion message. When you exit the Edit menu, commit setup changes or the password 
changes will be lost. 

RESET PASSWORDS 

This menu item causes the Setup and Diagnostic passwords to be reset to their original 
values. When this option is selected, you will be asked to enter a password. This function 
uses a special password which is used only for this function and cannot be changed. The 
password for this function will be given only to selected individuals. 

CONFIGURATION  

This menu item is used by Ultrasonic Arrays personnel to enable purchased options. This 
menu item is password protected and inaccessible to you except at the direction of Ultra-
sonic Arrays’ personnel. 

EXITING THE EDIT MENU 

Certain changes to setup parameters will not take effect until the next time MeasureMate 
software is run. A message will be displayed if changes have been made to such parame-
ters. If you wish the changes to take effect immediately, exit and then re-start Measure-
Mate; or pause and then run gauge communications. 
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SECTION 8 – THE VIEW MENU 

This menu is activated by selecting View from the Menu Bar.  

THICKNESS SUB-MENU 

Profile Chart 

The Profile Chart displays “real time” thickness readings for each panel as it moves 
through the TMS system. The chart graphically illustrates panel thickness measurements 
and how they relate to warning and error tolerances. One chart for each thickness gauge 
up to seven is simultaneously drawn on the screen. The profile chart is the default chart 
shown upon starting gauge communications if your system has the TMS component in-
stalled. 

Each profile has a gauge label for easy identification. This label can be altered as desired 
from the menu; see Section 3. The current profile will remain on the screen until the next 
panel has appeared in the thickness gauge measurement zone. The right side of each chart 
is labeled with values representing the following information (in order from top to bot-
tom): Upper Chart Scale, Upper Error Level, Upper Warning Level, Target Thickness 
(center) Lower Warning Level, Lower Error Level and Lower Chart Scale. These set 
points are established when parameters for a product are configured. 

If an individual measurement point is within specified limits, a line representing the meas-
ured thickness is drawn on the screen in green. If the thickness exceeds the warning levels, 
(upper or lower) the line will turn yellow. If the measurement exceeds the error levels 
(upper or lower) the line will turn red. Shading can be selected during Program Setup to 
increase the error and warning conditions more visible. Shading will cause the area be-
tween the actual values and the target values to be filled with green, yellow, or red de-
pending on the relationship of the data point to the warning and error limits. See Section 
3. 

Current Trend 

For a broader view of product measurement trends, select the Current Trend chart. This 
display shows the average thickness of the last 120 panels. If 120 panels have not yet been 
accumulated, it will plot all available data and update the screen as each successive panel 
is measured.  

Lines are drawn from the center line up if the average thickness of a panel is above the 
target or down if the average thickness is below the target thickness. If the average thick-
ness falls within the warning limits the vertical line will be green. If the average exceeds 
the warning limits, the line will be yellow. If the average exceeds the error limits the line 
will be red. 

Data for accumulated panels will be reset at change of product or at change of shift. 



 

44 

 

Range Trend  

The Range Trend chart graphs the range of the measurements from each gauge, for each 
panel, from the last load. Range is defined as the highest reading minus the lowest reading 
for a scan. This information is plotted by gauge for the last 120 panels. This chart is reset 
at product and shift changes. 

Panel Weight Trend (Optional) 

The Panel Weight Trend chart plots the weight of the last 120 panels. This chart is availa-
ble only on systems with Weigh Scale installed. This chart is reset at product and shift 
changes. 

Average Profile 

This chart displays the average profile for each active gauge, the average value for each of 
the last 50 panels for the current product. 

Composite 

This permits the selection of a group of sequential panels for analysis. Up to 50 panels 
may be chosen; all press loads must be for the same product. Average readings are com-
puted for all the panels from all the press loads chosen, making a composite panel. The 
thickness values are charted for each gauge for the composite panel. Upon selection, the 
user is prompted for the first and last panels desired for analysis. 

Thickness Data 

Thickness Data is an alpha-numeric representation of thickness data displayed in the Data 
Wndow. Using specified function keys, the operator may select which thickness data is 
displayed. When Run is first selected after starting MeasureMate, Thickness Data is dis-
played along with the Panel Chart. 

Thickness Data provides function keys to cycle several data screens. The function keys 
will work only if the Thickness Data window is the active window. 

BOND ANALYSIS SUB-MENU 

This menu contains the charting options available in MeasureMate Software for Bond 
Analysis. The Bond Analysis sub-menu is accessed by clicking of the View menu and se-
lecting Bond Analysis. 

Channels are normally numbered from one side of the panel to the other. This scheme 
changes, however, when two conditions are present. They are: 

1. The width of the panels varies between products 

2. The panel is centered on the line.  

Under these circumstances, the first channel is in the center of the panel, and the gauges 
are numbered from the center out; odd numbered gauges on top. For a more detailed ex-
planation see Product Widths in Section 4, Installation and Program Configuration. 
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Panel 

This option graphs blows and warnings for the panel that was just completed (just passed 
under the BMS gauges). Up to 16 charts are produced, one for each gauge. The length of 
the panel is represented horizontally on the chart. Readings of no warnings or blows are 
shown with a thin green line. Warnings are shown with a wider yellow block, and blows 
are shown as a still wider red block.  

BOND INTEGRITY 

In manufactured panels, defects in bond integrity can be determined by the sound trans-
mission properties of the completed panel. Two pieces of wood that are well bonded 
transmit sound well, while two pieces of wood that are unbonded or poorly bonded do 
not. The bond integrity chart shows the amplitude of the ultrasound pulses received after 
traveling through the panel being tested. The chart is similar to a topographical map that 
shows the height of mountains and valleys using color; the bond integrity chart shows the 
amplitude of received sound using color. A scale showing the relationship between color 
and reading value is shown on the bottom of the chart. If a blow is detected then the am-
plitude is not shown. The blown areas of the panel are displayed in red. 

SPREADSHEET 

This screen is a very quick method of obtaining data on recent production. Spreadsheet 
will provide overall data on the last panel, the previous panel, and the last ten panels. 
Spreadsheet is not a chart but a text-based report. The spreadsheet cannot be printed. 
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 SECTION 9 - PAUSE/RUN 

Pause/Run is not a menu, but a command. It does not indicate the current status of gauge 
communications. If MeasureMate is currently communicating with the gauges, the com-
mand Pause is displayed. If communications are currently halted, the command Run is 
diaplayed. 

RUN 

To begin gauge communication when starting up the system, or to resume gauge commu-
nications after a Pause, position the pointer on Run and click the mouse button. If the sys-
tem is configured as a TMS only or combination TMS/BMS system, the Profile Chart will 
automatically be displayed, along with Thickness Info. In a system with BMS only, the 
Panel chart will be automatically displayed. 

PAUSE 

To suspend gauge communications, select Pause and click the left mouse button. 
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 SECTION 10 –  THE REPORTS MENU 

Selection of the Reports menu allows the user to choose from a selection of predefined 
reports.  

Available printer reports are: 

 Product Report 

 Shift Report 

 Alarm Report  

 Opening Range 

 Panel Report 

 Shift Summary 

 Alarm Output Config 

 Setup Report  

 Product List 

 Print Screen 

Reports are selected by moving the cursor to Reports on the menu bar and clicking the 
left mouse button. The system will ask the operator if the report should be displayed on 
the screen or sent to the printer.  

Once the report has been selected, you will be asked to specify the report destination. 
Three choices are possible: 

 To the printer (reply with the letter “P”). 

 To the screen (reply with the letter “S”). 

 To the disk (reply with the letter “D”). 

Selection of the Screen option will open a separate session of the Windows Notepad ap-
plication; thus, several reports may be open simultaneously. 

NOTE: Make sure the printer is on-line before selecting it as the report destination. 

If you have chosen the “Panel Report” you will next be asked to specify the panel number.  

If you routed the print to disk, printing will be completed with no feedback to you. Each 
report will be placed in its own file in the MeasureMate directory. The format of the re-
port is the same as if it had been printed, including all page headings and printer control 
characters. File names are assigned as follows: 

 Alarm Report   ALARMnnn.RPx 

 Opening Range Report   OPNRGnnn.RPx 

 Output Report   OUTPTnnn.RPx 

 Panel Report    PANELnnn.RPx 
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 Product Report   PRDCTnnn.RPx 

 Setup Report     SETUPnnn.RPx 

 Shift Report     SHIFTnnn.RPx 

The “nnn” in the name above is a sequentially assigned number. This provides a unique file 
name for each report, allowing the operator to store several of the same type of report. 

The “x” in the names above indicates which execution of MeasureMate the report is from. 
Choices follow: 

 RPT - The last run of MeasureMate. 

 RP2 - The run of MeasureMate prior to the last one. 

 RP3 - The run of MeasureMate three executions ago. 

Reports are kept for three runs of MeasureMate, afterwhich the reports are deleted to 
save disk space. To retain reports that would otherwise be deleted, it is recommended that 
report files be copied to storage media. 

PRODUCT REPORT 

This selection produces a report that summarizes production data for the current product 
type. This is a highly summarized report which lists the number of boards and press loads 
that were run, the average thickness and average standard deviation of the panels. It also 
lists the measurements by the individual gauges with the alarms detected. Since this is a 
highly summarized report it is a short report. See Appendix A for a sample of the report 
output. 

SHIFT REPORT 

The Shift Report lists the total panels and press loads run, during the current shift. The  
average thickness, the average delta from the target thickness, and the average density for 
all panels of the product are also printed out. Shift Reports also list the average, the delta 
from the target thickness, and the average density for each press load. The report is time 
and date stamped. There must be at least one valid press load in order to print this report. 
See Appendix B for a sample of the report output. 

ALARM REPORT 

The Alarm Report summarizes the number of panels for which a thickness error (over or 
under) or bond alarm condition occurred. This report should not be confused with the 
Alarm Configuration report printed during program setup. The report has two sections, a 
summary section followed by a detail section. In the detail section one line is produced for 
every alarm produced.  See Appendix C for a sample of the output. 



 

51 

 

OPENING RANGE REPORT 

The Opening Range Report is a summary of the opening range data listed by gauge and 
the average range for the opening. Range is the highest reading minus the lowest reading 
for the panel.  

PANEL REPORT 

The Panel Report lists the individual gauge measurements for a panel. The printout lists 

the date and time the panel was measured, as well as the product type, an ordered list of 

the individual measurements by gauge, the average dimension, and the standard deviation 

of the measurements. See Appendix D for sample output. 

SHIFT SUMMARY 

This report produces a summary of products run during the shift. One line is produced for 

each product run. If a product is run two or more times during a shift, each run is listed 

separately on the report.  

Your alarm setup determines which warning and error levels are reported. This provides 

you the flexibility to set up unusual conditions. If you sand your panels you may wish to 

reject based on the warning level on the thin side, and reject on the error level on the thick 

side. Since panels alarmed as errors will also be alarmed as warnings, summing the percen-

tages for warnings, errors and on-target panels will not always add up to 100%; however, 

it should be easy to understand the difference if you understand how alarms are set up. In 

a system where both under and over conditions are alarmed for both error and warning 

limits, then the warning percentage and on-target percentage will add up to 100% 

ALARM OUTPUT CONFIGURATION REPORT 

This report lists the current alarm configuration data if the optional alarm software pack-

age is configured for your system. It is recommended that a printout of the most current 

Output Configuration Report be stored in the pocket provided in this manual. See Appen-

dix E for sample output. 

SETUP REPORT 

The Setup Report lists the system’s setup parameters. It is recommended that a printout of 

the most current Setup Report be stored in the pocket provided in this manual so that the 

setup can be restored if the setup file is accidentally changed. See Appendix F for sample 

output. 

PRODUCT LIST 

This report produces a list of your product setup. The report shows whether each product 

has been learned (BMS). 
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PRINT SCREEN 

Whatever is currently displayed on the screen can be written to the printer. It takes about 

two minutes to print an image of the screen, because of the high resolution graphics in-

volved. 

To print the screen, select Print Screen from the Reports menu. 

NOTE: The system will not allow any more print screens until the previous screen is 

completely printed. 
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 SECTION 11 - THE DATA WINDOW 

A powerful feature of MeasureMate software is the data window. Its purpose is to pro-
vide users with summary data by press load without having to switch screens. The win-
dows may be changed by using specified function keys. The function keys will work only 
if the Data Window is the active window. 

LAST PANEL 

Shows summary data for the last panel that was sampled. This information is grouped by 
gauge with a composite average for each gauge, and for all 3 gauges at the bottom. The 
gauge information shown in the Data Window includes the average thickness, the standard 
deviation (Sigma), and the minimum and maximum values of the readings, and the differ-
ence between the average value and the target value (Delta). 

The Panel Average data information shown in the Data Window includes: the average 
thickness for all the gauges, the average of the standard deviations for the gauges (Sigma), 
the weight of the panel (if the weigh scale option is included) and the average density of 
the panel (if the weigh scale option is included). 

In the current panel window color is used to indicate the status of the various statistical 
values. If the average is outside the warning levels, (or the error levels) the average of the 
data window will turn yellow (or red). If the Standard Deviation calculated for a particular 
panel exceeds the value for sigma entered in the Target Edit screen of the Products menu, 
the calculated value for sigma, in the data window will turn red to signify an error condi-
tion. If the Delta is greater than the warning (or error) limits, then the Delta value in the 
data window will turn yellow (or red). 

CURRENT SHIFT 

Pressing the function key <F1> from the Last Panel data screen changes the data window 
to show the average thickness and average delta for the most recent 32 pressloads. The 
function key <F2> can be used to swap between the data for the most recent 32 press-
loads and the 18 pressloads before that. This allows a total of 50 pressloads to be viewed. 
Pressing the function key <F1> from this data screen changes the data window back to 
Last Panel. 
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 SECTION 12 - RUNNING RPSS 

RPSS is a MeasureMate reporting program used to produce reports from MeasureMate 
history files.   

RPSS will produce a wide variety of reports, and the reports may be tailored to suit your 
requirements; however individual readings for panels are not available for RPSS reporting. 
They are discarded to save space on your hard drive. Summary level information such as 
panel averages, maximum reading, minimum reading, sigma, number of blows, etc., is 
available. 

HISTORY FILES 

Each history file is really a matched set of 3 files. See Section 4, Installation and Configu-
ration, for a description of the files and filenames. 

DATA AVAILABILITY 

The only history file unavailable for reporting is the history file currently being built by 
MeasureMate. 

If History Autosave Days is enabled, MeasureMate automatically deletes old history files. 
If history files were allowed to accumulate unchecked they would eventually fill your disk 
and cause MeasureMate to crash for lack of disk space. To prevent crashes of this nature 
MeasureMate deletes files when they are several days old. You may specify the number of 
days MeasureMate is to keep history files. From the MeasureMate program select “Edit” 
from the main menu then “Program settings” from the drop down menu. Enter your instal-
lation’s password.  The parameter to change is labeled “History Autosave days”. In this 
case “Autosave” means automatically delete after the specified number of days. 

Data may be saved beyond the normal deletion time by doing either of two things: 

1. Rename the file name to something else. Do not change the extension name (“.DAT”, 
“.IDX”, & “.ref”); instead the first name. Change the name so that the first 3 charac-
ters are something other than “HST” since MeasureMate matches on those characters 
for deletion purposes.  Each of the three components of the history file must be 
changed so that the first name matches. Note that simply changing the first character in 
the file name to an “X” or changing “HST” to “SAV” will accomplish this. 

2. Move or copy the files to another directory on your disk or onto other storage media. 

PREDEFINED REPORTS 

Detail 

Provides one line on the report for each panel graded. Total lines are produced at change 
of product and at end of shift. 

Summary for Each Load 

Writes total lines for each load graded. No detail lines are produced at the panel level. 
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Summary for Each Run of a Product 

This report produces total lines at the end of each product and at end of shift. No detail 
lines are produced at the panel level. 

Product Summary with Runs Combined 

This report is the same as the one above except that if a product is run several times in a 
day, all the runs of that product are totaled together and reported as one set of total lines. 

Summary by Time Interval 

This report can tell you that in this 15 minute period we produced so many panels and had 
so many thickness/bond problems, and in the next 15 minute period we produced so many 
panels and had so many thickness/bond problems.  The “Time Interval” field to the right 
specifies the length of each time interval. If  “product name” is included in the report then 
the first product run in the time interval is reported. 

Alarm Detail 

History records are screened for alarms or blows. Detail lines for records with alarms or 
blows are shown. Totals are displayed at the end of each product run and at end of shift. 

GENERATING A REPORT 

Generating a report is a two step process. 

1. Select Report from the main menu, then Edit or Load, depending upon the desired 
report. 

2. From the File menu, select open, then choose the desired history file. 
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EDITING A REPORT 

All RPSS predefined reports are designed to be easily customizable by the user. To open 
or customize an RPSS report, from the Report menu, select Edit. The following dialog 
box will be displayed. 

 

Select the desired report type from the choices provided. If the Time Interval report is se-
lected, also enter the Time Interval in minutes in the space provided. 

Determine whether you wish to have total lines and/or a grand total line at the end. If you 
are going to produce spreadsheet output, the total lines may interfere with the spreadsheet 
functions you are going to want to do. Summary reports (no detail lines) include totals. If 
you choose a summary level report and do not select total lines, RPSS will turn total lines 
on for you. 
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If you plan to customize the report, enter a title that will accurately reflect the contents of 

the report. 

Click OK. The Field Selection Dialog box will be displayed. 

 

This dialog box allows the user to select the specific fields that will appear on the report. 
Clicking on the check box next to an item will cause that item to appear on the report. If 
the check box next to an item is clear, the item will not appear. 

Note: The boxes checked in the dialog box may differ from the boxes checked in the ex-
ample above.  The checked boxes reflect the makeup of the report loaded when you 
started report edit. The selections here are for the default RPSS report. 

To print the default fields for the report selected, click OK. To customize a report, select 
the desired fields from those detailed below. 
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Field Options 

The table below details what information will appear detail lines (for non-summary re-
ports), in title lines, and in the header for each field. 

Field Title Detail Line Total Line Grand Totals 

Time Time Panel Finish Time Time for first of to-

taled panels 

“********” 

Product 

Name 

Product 

Name 

Name given in 

product setup 

Name given in prod-

uct setup
1 

“Grand To-

tals” 

Target Target TMS Thickness 

target 

TMS Thickness tar-

get 

“*****” 

Load  Load Load Number for 

Panel 

“****” “****” 

Opening Op Opening Number 

for Panel 

“**” “**” 

Panel Count Panel Count Blank Number of panels Number of 

panels 

Alarms 
2 

Yes/No 

Alarm Y/N “Yes” or No Count: number of 

panels 

with alarms 

Count of pa-

nels 

with alarms 

Alarms 
2
 

List 

List of 

Alarms 

List of alarms e.g. 

“2,5,7” 

Count: number of 

panels with alarms 

Count of pa-

nels w/ alarms 

Weight Weight Panel Weight 
3
 Average Panel 

Weight 
3 

Blank 
 

Density Density Panel Density 
3
 Average Panel Den-

sity 
3
 
 

Blank 
 

# Blows in 

Panel 

Bond Blows Number blow 

alarms in panel 

Number of panels 

with blows 

No. panels 

with blows 

# Warns in 

Panel 

Bond Warns  Number warning 

alarms in panel 

Number of panels 

with warnings 

No. panels 

with warnings 

1 
In the summary by time interval, the name shown is the name of the product for the first 
panel in the period. Since the product may change at any time, the product may be differ-
ent than the ending panel in the same period. 

2 
Some alarms, such as alarm every so many panels, do not represent errors, and should be 
excluded from error reporting. If you use those alarms you may exclude them from re-
porting by checking the appropriate box in the “Ignore alarms on these outputs” section 
of the dialog box.  

3 
Available only if you have a weigh scale. The field will be blank if you do not have a 
scale. 
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The following fields may be selected for either the gauge level or the panel level. If the 
panel level is selected then one column will be generated for each gauge on your system. 
The first line in the title will have “Gau 1  Gau 2  Gau 3 …”.  

The following table lists fields available for panel selection.  

Field Title Detail Line Total Line Grand Totals 

Average Panel 

Thick 

Average thickness Average thickness Average thickness 

Delta Panel 

Delta 

Average thickness 

minus target 

Average differ-

ence from target 

Avg. dif. from 

target 

Largest 

Reading 

Max 

Thick 

Maximum reading 

for panel 

Blank Blank 

Smallest 

Reading 

Min 

Thick 

Minimum reading 

for panel 

Blank Blank 

Reading 

range 

Panel 

Range 

Maximum minus 

minimum 

Blank Blank 

Sigma Panel 

Sigma 

Thickness sigma 

(standard devia-

tion) 

Average thickness 

sigma 

Average thickness 

sigma 

No Refer-

ence bar 
1 

Panel 

NoRef 

Number of no ref 

bar readings 

Number of no ref 

bar readings 

Number of no ref 

bar readings 

No Target
1
 Panel 

NoTar 

Number of no tar-

get readings 

Number of no 

target readings 

Number of no 

target readings 

1
 Both “No Reference bar” readings and “No Target” readings represent errors. No refer-
ence bar means that the gauge could not return a reading because it could not detect the 
reference bar attached to the gauge. Common causes include dust on the reference bar, 
improperly installed or dirty environmental filters, or bad transducers. See gauge docu-
mentation. “No Target” may be caused by many of the same problems, but may also be a 
“Normal” error.  Any abnormality in or on the panel which causes reflected sound to be 
sent off into space rather than back to the transceiver may cause the problem. Chips on 
the panel or irregularities in untrimmed edges may cause “No Target” readings, and do 
not represent real problems.  

All the fields above may appear in detail lines (except in summary reports) and in total 
lines. The total lines follow the same columnar format as the detail line. There are a few 
fields which may appear in a second total line. That total line does not follow  the colum-
nar format of the rest of the report. Fields which may be included on that line include: 

1. Panel count (Panel Count = nnnn),  Number of panels 
2. % with no problem (Good Panels = nn.n%), per-cent of panels with no alarms or 

blows. 
3. % with alarms (Panels with alarms = nn.n%), Per-cent of panels that have alarms.  
4. % with blows (Panels with blows = nn.n%), Per-cent of panels that have blows. Avail-

able only if your system has BMS (bond). 
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You may ignore specific alarm outputs in these figures by marking the appropriate alarm 
output(s) in the “Ignore alarms on these outputs” section of the dialog box. 

The “Number TMS gauges” field is used by the reporting system in determining the num-
ber of columns to make for the “By Gauge” fields. If you leave the “Number TMS gaug-
es” field zero RPSS will determine the number of gauges by looking at the first history 
record. That will work well except if you have narrow and wide products. If the history 
file starts with a narrow product, the number of gauges will not be increased when you 
come to a wider product. If your product widths vary and have requested “by gauge” 
fields, enter the number of gauges that will be used for wide products in the “Number 
TMS gauges” field.  

“Group Indicate” means that the field’s value is listed only when it changes and at the top 
of the page. “Group Indicate” has not yet been implemented. When it is implemented 
“Group Indicate on a separate line” will allow you to reduce the width of your lines. 

When you are satisfied with the fields included on the report select OK. You may now 
view the report by selecting data to report, save the report, or re-edit the report. You may 
repeatedly edit the report and view data until you are satisfied with the report and then 
save the report’s format. 

SAVING A REPORT FORMAT 

From the Report menu, select Save. A standard Windows file save dialog box will be dis-
played with the report title entered as the default file name. It is recommended that you 
use the default filename to avoid confusion. Click SAVE to save the report format. 

SELECTING DATA TO REPORT 

After the selecting the report format, the user must select data to be reported. 

From the File menu, select Open or choose one of the recently used files listed at the bot-
tom of the File menu. The Open File dialog box will be displayed. The default file type is 
.dat (data) files; the default directory is the “mmate” directory. When the desired file is 
highlighted, click OPEN. 

OUTPUT TO A SPREADSHEET 

With the desired report displayed, select Save Spreadsheet Data from the File menu. A 
standard Windows Save As dialog box will be displayed. Enter a filename and click SAVE. 

OUTPUT TO A PRINTER 

With the desired report displayed, select Print from the File menu. 
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APPENDIX A - THE PRODUCT REPORT 

 

PRODUCT REPORT 

Tue Jun 04 13:05:47 1996 

 

Shift: 1 

 

0.625 

 

Total Panels:       19 

 

              Gauge 1      Gauge 2      Gauge 3    

Opening    Avrage Sigma Avrage Sigma Avrage Sigma 

Num/Name   Inches       Inches       Inches      

 

1 op1      0.628 0.002  0.624 0.002  0.625 0.002  

 

              Total     Off    Average 

Opening     Average  Target    Density 

Num/Name     Inches  Inches  Lbs/Cu.Ft 

 

 1 op1        0.626   0.001     59.880 

 
 

 

Total Average Thickness:    0.626" 

Total Average Off Target:   0.0005" 

Total Average Density:     59.911 Lbs/Cu. Ft. 
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APPENDIX B - THE SHIFT REPORT 

 
 

SHIFT REPORT 

 

Tue Jun 04  14:44:29  1966 

 

Shift 1 

 

 

Total Panels = 359,  Rejected Press Loads = 2 

 

     Product Load Cnt  Average   Off Target   Avg. Density       Blown Pnls        

       0.625     1      0.627"     0.001"     59.857 Lbs/Cu. Ft.    2        

       0.625     2      0.626"     0.001"     59.905 Lbs/Cu. Ft.    2        

       0.625     3      0.625"     0.000"     59.976 Lbs/Cu. Ft.    1      

       0.625     4      0.626"     0.001"     59.904 Lbs/Cu. Ft.    2        

       0.625     5      0.625"     0.000"     60.001 Lbs/Cu. Ft.    1      

       0.625     6      0.624"    -0.001"     60.121 Lbs/Cu. Ft.    2      

       0.625     7      0.624"    -0.001"     60.098 Lbs/Cu. Ft.    2      

       0.625     8      0.627"     0.002"     59.809 Lbs/Cu. Ft.    1 

       0.625     9      0.625"     0.000"     60.048 Lbs/Cu. Ft.    2 

       0.625    10      0.624"    -0.001"     60.072 Lbs/Cu. Ft.    1 

       0.625    11      0.627"     0.002"     59.857 Lbs/Cu. Ft.    1       

       0.625    12      0.625"     0.000"     59.976 Lbs/Cu. Ft.    2 

**Total Prod    12      0.625"     0.000"     59.969 Lbs/Cu. Ft.   19 

 

 0.625 no. 3     1      0.624"    -0.002"     60.145 Lbs/Cu. Ft.    1 

 0.625 no. 3     2      0.625"     0.000"     59.977 Lbs/Cu. Ft.    1 

 0.625 no. 3     3      0.625"     0.000"     60.048 Lbs/Cu. Ft.    1 

 0.625 no. 3     4      0.625"     0.000"     59.976 Lbs/Cu. Ft.    2  

 0.625 no. 3     5      0.625"     0.000"     60.048 Lbs/Cu. Ft.    1 

**Total Prod     5      0.624"     0.000"     60.039 Lbs/Cu. Ft.    6 
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APPENDIX C - THE ALARM REPORT 

 
 

ALARM REPORT 

 

Tue Jun 04  14:44:29  1966 

 

Shift: 1 

 

0.625 

 

Opening #        TMS Alarms       BMS Alarms 

    1                  2                4 

 

                        Alarms for Shift 

 

   1       Load   1      Opening  1        Panel    0       BMS 

   2       Load   5      Opening  1        Panel   20       BMS 

   3       Load   5      Opening  1        Panel   21       TMS 

   4       Load  10      Opening  1        Panel   40       BMS 

   5       Load  11      Opening  1        Panel   44       BMS 

   6       Load  11      Opening  1        Panel   45       TMS 
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APPENDIX D - THE PANEL REPORT 

 

PANEL DATA REPORT 

 

Tue Jun 04  14:44:29  1966 

 

Shift: 1 

 

0.625 

 

Panel Number:      20 

Panel Density:     60.289 

 

Gauge Name----> Gauge 1    Gauge 2    Gauge 3     

Average         0.629"     0.619"     0.619"  

Std. Dev.     0.002"     0.002"     0.004"  

Sample Number 

   1            0.625"     0.625"     0.625" 

   2            0.625"     0.625"     0.625"  

   3            0.625"     0.626"     0.626"  

   4            0.626"     0.626"     0.626"  

   5            0.626"     0.626"     0.626"  

   6            0.626"     0.626"     0.626"  

   7            0.626"     0.625"     0.626"  

   8            0.626"     0.625"     0.625"  

   9            0.626"     0.624"     0.625"  

  10            0.627"     0.624"     0.625"  

  11            0.627"     0.623"     0.624"  

  12            0.627"     0.623"     0.623"  

  13            0.628"     0.623"     0.623"  

  14            0.628"     0.622"     0.624"  

  15            0.629"     0.621"     0.624"  

  16            0.629"     0.621"     0.624"  

  17            0.630"     0.621"     0.624"  

  18            0.630"     0.621"     0.623"  

  19            0.629"     0.621"     0.622"  

  20            0.630"     0.620"     0.622"  

  21            0.629"     0.619"     0.622"  

  22            0.629"     0.620"     0.622"  

  23            0.630"     0.619"     0.623"  

  24            0.630"     0.618"     0.623"  

  25            0.631"     0.618"     0.623"  

  26            0.631"     0.618"     0.623"  

  27            0.630"     0.618"     0.623"  

  28            0.630"     0.618"     0.623"  

  29            0.630"     0.618"     0.622"  

  30            0.630"     0.618"     0.622"  

  31            0.631"     0.618"     0.622"  

... 
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PANEL DATA REPORT 

 

Tue Jun 04  14:44:29  1966 

 

Shift: 1 

 

0.625 

 

Panel Number:      20 

Panel Density:     60.289 

 

Gauge Name----> Gauge 1    Gauge 2    Gauge 3     

Sample Number 

  39            0.627"     0.617"     0.621"  

  40            0.628"     0.618"     0.620"  

  41            0.628"     0.617"     0.620"  

  42            0.627"     0.617"     0.620"  

  43            0.628"     0.617"     0.621"  

  44            0.629"     0.618"     0.622"  

  45            0.630"     0.618"     0.621"  

  46            0.629"     0.618"     0.622"  

  47            0.629"     0.618"     0.621"  

  48            0.629"     0.618"     0.620"  

  49            0.630"     0.618"     0.620"  

  50            0.631"     0.618"     0.620"  

  51            0.631"     0.618"     0.620"  

  52            0.631"     0.617"     0.621"  

  53            0.630"     0.618"     0.622"  

  54            0.630"     0.618"     0.622"  

  55            0.629"     0.618"     0.622"  

  56            0.629"     0.617"     0.622"  

  57            0.628"     0.617"     0.621"  

  58            0.627"     0.618"     0.620"  

  59            0.627"     0.617"     0.619"  

  60            0.627"     0.618"     0.618"  

  61            0.627"     0.617"     0.618"  

  62            0.627"     0.616"     0.618"  

  63            0.627"     0.616"     0.618"  

  64            0.627"     0.616"     0.618"  

  65            0.627"     0.617"     0.617"  

  66            0.627"     0.617"     0.617"  

  67            0.626"     0.617"     0.616"  

  68            0.626"     0.618"     0.615"  

  69            0.627"     0.619"     0.615"  

  70            0.626"     0.620"     0.615"  

  71            0.627"     0.620"     0.616"  

  72            0.627"     0.619"     0.616"  

  73            0.628"     0.619"     0.616"  

  74            0.629"     0.619"     0.616"  

... 
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PANEL DATA REPORT 

 

Tue Jun 04  14:44:29  1966 

 

Shift: 1 

 

0.625 

 

Panel Number:      20 

Panel Density:     60.289 

 

Gauge Name----> Gauge 1    Gauge 2    Gauge 3     

Sample Number 

  78            0.630"     0.619"     0.614"  

  79            0.630"     0.619"     0.615"  

  80            0.630"     0.619"     0.614"  

  81            0.630"     0.619"     0.614"  

  82            0.630"     0.618"     0.614"  

  83            0.630"     0.618"     0.614"  

  84            0.630"     0.619"     0.614"  

  85            0.629"     0.619"     0.613"  

  86            0.630"     0.619"     0.612"  

  87            0.629"     0.619"     0.612"  

  88            0.629"     0.619"     0.611"  

  89            0.629"     0.620"     0.610"  

  90            0.630"     0.620"     0.611"  

  91            0.631"     0.620"     0.611"  

  92            0.631"     0.620"     0.611"  

  93            0.632"     0.620"     0.612"  

  94            0.632"     0.621"     0.613"  

  95            0.632"     0.622"     0.614"  

  96            0.632"     0.621"     0.615"  

  97            0.632"     0.622"     0.616"  

  98            0.632"     0.622"     0.616"  

  99            0.632"     0.621"     0.616"  
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APPENDIX E - THE ALARM OUTPUT CONFIGURATION REPORT 

 

ALARM OUTPUT CONFIGURATION REPORT 

 

Tue Jun 04  14:44:29  1966 

 

 

Alarm Configuration Summary: Output #  1  

 

 Delay in Seconds =    0.1 

 Dwell in Seconds =    0.3 

 

 T  Type  Gauge   Limit   Value  Smps Row 

 ---------------------------------------- 

 0 Bond     n/a     n/a     n/a     n/a 

 1 Idle                                 

 2 Idle                                 

 3 Idle                                 

 4 Idle                                 

 5 Idle                                 

 6 Idle                                 

 7 Idle                                 

 

Alarm Configuration Summary: Output #  2  

 

 Delay in Seconds =    0.0 

 Dwell in Seconds =    0.5 

 

 T  Type  Gauge   Limit   Value  Smps Row 

 ---------------------------------------- 

 0 Profile  All   > ELVL    n/a      1  

 1 Profile   1    > ELVL    n/a      1  

 2 Idle                                 

 3 Idle                                 

 4 Idle                                 

 5 Idle                                 

 6 Idle                                 

 7 Idle                                 

 

Alarm Configuration Summary: Output #  3  

 

 Delay in Seconds =    0.1 

 Dwell in Seconds =    0.6 

 

 T  Type  Gauge   Limit   Value  Smps Row 

 ---------------------------------------- 

 0 Profile  All   < ELVL    n/a      1  

 1 Profile   1    < ELVL    n/a      1  

 2 Idle                                 

 3 Idle                                 

... 

Page 1 



 

74 

 

ALARM OUTPUT CONFIGURATION REPORT 

 

Tue Jun 04  14:44:29  1966 

 

 

Alarm Configuration Summary: Output #  4  

 

 Delay in Seconds =    0.1 

 Dwell in Seconds =    0.6 

 

 T  Type  Gauge   Limit   Value  Smps Row 

 ---------------------------------------- 

 0 Profile  All   < ELVL    n/a      1  

 1 Profile   1    < ELVL    n/a      1  

 2 Idle                                 

 3 Idle                                 

 4 Idle                                 

 5 Idle                                 

 6 Idle                                 

 7 Idle                                 

 

Alarm Configuration Summary: Output #  5  

 

 Delay in Seconds =    0.1 

 Dwell in Seconds =    0.4 

 

 T  Type  Gauge   Limit   Value  Smps Row 

 ---------------------------------------- 

 0 Profile  All   < WLVL    n/a      1  

 1 Profile   1    < WLVL    n/a      1  

 2 Idle                                 

 3 Idle                                 

 4 Idle                                 

 5 Idle                                 

 6 Idle                                 

 7 Idle                                 

 

Alarm Configuration Summary: Output #  6  

 

 Delay in Seconds =    0.0 

 Dwell in Seconds =    1.0 

 

 T  Type  Gauge   Limit   Value  Smps Row 

 ---------------------------------------- 

 0 Profile   2    > ELVL    n/a      1  

 1 Idle                                 

 2 Idle                                 

 3 Idle                                 

 4 Idle                                 

 5 Idle                                 

 6 Idle                                 

 7 Idle                                 
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ALARM OUTPUT CONFIGURATION REPORT 

 

Tue Jun 04  14:44:29  1966 

 

 

Alarm Configuration Summary: Output #  7  

 

 Delay in Seconds =    0.0 

 Dwell in Seconds =    1.0 

 

 T  Type  Gauge   Limit   Value  Smps Row 

 ---------------------------------------- 

 0 Profile   3    > ELVL    n/a      1  

 1 Idle                                 

 2 Idle                                 

 3 Idle                                 

 4 Idle                                 

 5 Idle                                 

 6 Idle                                 

 7 Idle                                

 

 

 Alarm Configuration Summary: Output #  8  

 

 Delay in Seconds =    0.0 

 Dwell in Seconds =    0.0 

 

 T  Type  Gauge   Limit   Value  Smps Row 

 ---------------------------------------- 

 0 Idle                                 

 1 Idle                                 

 2 Idle                                 

 3 Idle                                 

 4 Idle                                 

 5 Idle                                 

 6 Idle                                 

 7 Idle                                 
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APPENDIX F - THE SETUP REPORT 

 

PANEL DATA REPORT 

 

Tue Jun 04  14:44:29  1966 

 

Shift: 1 

 
Software Revision:.. 4.24 

Setup File:......... prod.dat 

Number of Gauges:...   3 

   Gauge/Scan Name: 0  Gauge 1        

   Gauge/Scan Name: 1  Gauge 2        

   Gauge/Scan Name: 2  Gauge 3         

Plot Direction:..... Left to Right 

No. Active Gauges:..   3 

Line Speed:......... 190 

Sample Time:........   1 

BMS/TMS:............ BMS & TMS 

History:............ Yes 

Alarms:............. Yes 

Weigh Scale:........ Yes  Parallel Before Gauges 

Corners:............ Yes 

Shading:............ On 

Board Length:.......  16 feet 

Samples per Board:.. 100 

Edge Skips:.........   3 

Sub Group Size:.....   1 

Units:.............. ENGLISH 

Board Area:......... 32.00 square feet 

Density Histogram Limits  Low: 55.00 High 65.00 

History Drive:...... C 

Digital I/O Port:... 0x320 

Counter Port:....... 0x0 

BMS Port Number:.... 2 

Qty BMS gauges:..... 2 

Shift Start Times:.. 800, 1630, 100, -1 

Autosave Days:...... 2 

Product Order:...... Sorted by Title 

Printer Type:....... Epson LQ 

Auto Print:......... No 

Product Widths:..... Vary 
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Definition of Selected Product 

PRODUCT   1:   0.625 

 

 

Bank Number:.......    3 

Size of a sample:..    8 

Blow level:........  200 

Blow Size:.........   18 

Warning level:.....  190 

Warning Size:......   10 

 

Opening:............    1 

     Unload Seq:....    1 

     Target:........ 0.625 

     Delta:......... 0.020 

     Warning Level:. 0.007 

     Error Level:... 0.014 

     Target Weight:. 100.00 

     Weight Error:.. 0.010 

     Sigma:......... 0.005 

 

Opening:............    2 

     Unload Seq:....    2 

     Target:........ 0.625 

     Delta:......... 0.020 

     Warning Level:. 0.007 

     Error Level:... 0.014 

     Target Weight:. 100.00 

     Weight Error:.. 0.010 

     Sigma:......... 0.005 

 

Opening:............    3 

     Unload Seq:....    3 

     Target:........ 0.625 

     Delta:......... 0.020 

     Warning Level:. 0.007 

     Error Level:... 0.014 

     Target Weight:. 100.00 

     Weight Error:.. 0.010 

     Sigma:......... 0.005 

 

Opening:............    4 

     Unload Seq:....    4 

     Target:........ 0.625 

     Delta:......... 0.020 

     Warning Level:. 0.007 

     Error Level:... 0.014 

     Target Weight:. 100.00 

     Weight Error:.. 0.010 

     Sigma:......... 0.005 
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APPENDIX H - NET DDE I/O TAG NAMES 

TMSReadings    

Thickness gauge 1 reading 1 sThk1Pnt1 float TMS 

Thickness gauge 2 reading 1 sThk2Pnt1 float  TMS 

Thickness gauge 3 reading 1 sThk3Pnt1 float  TMS 

Thickness gauge 4 reading 1 sThk4Pnt1 float  TMS 

Thickness gauge 5 reading 1 sThk5Pnt1 float  TMS 

Thickness gauge 6 reading 1 sThk6Pnt1 float  TMS 

Thickness gauge 7 reading 1 sThk7Pnt1 float  TMS 

Thickness gauge 1 reading 2 sThk1Pnt2 float  TMS 

Thickness gauge 2 reading 2 sThk2Pnt2 float  TMS 

Thickness gauge 3 reading 2 sThk3Pnt2 float  TMS 

Thickness gauge 4 reading 2 sThk4Pnt2 float  TMS 

Thickness gauge 5 reading 2 sThk5Pnt2 float  TMS 

Thickness gauge 6 reading 2 sThk6Pnt2 float  TMS 

Thickness gauge 7 reading 2 sThk7Pnt2 float  TMS 
    
    
    

Thickness gauge 1 reading 48 sThk1Pnt48 float  TMS 

Thickness gauge 2 reading 48 sThk2Pnt48 float  TMS 

Thickness gauge 3 reading 48 sThk3Pnt48 float  TMS 

Thickness gauge 4 reading 48 sThk4Pnt48 float  TMS 

Thickness gauge 5 reading 48 sThk5Pnt48 float  TMS 

Thickness gauge 6 reading 48 sThk6Pnt48 float  TMS 

Thickness gauge 7 reading 48 sThk7Pnt48 float  TMS 

    

LastPanel    

Average Panel Thickness All Gauges sAveThk float  TMS 

Panel Standard Deviation All Gauges sStdDev float  TMS 

Average Panel Thickness Gauge 1 s1AveThk float  TMS 

Average Panel Thickness Gauge 2 s2AveThk float  TMS 

Average Panel Thickness Gauge 3 s3AveThk  float  TMS 

Average Panel Thickness Gauge 4 s4AveThk  float  TMS 

Average Panel Thickness Gauge 5 s5AveThk  float  TMS 

Average Panel Thickness Gauge 6 s6AveThk  float  TMS 

Average Panel Thickness Gauge 7 s7AveThk  float  TMS 

Panel Standard Deviation Gauge 1 s1StdDev  float  TMS 

Panel Standard Deviation Gauge 2 s2StdDev  float  TMS 

Panel Standard Deviation Gauge 3 s3StdDev  float  TMS 

Panel Standard Deviation Gauge 4 s4StdDev  float  TMS 

Panel Standard Deviation Gauge 5 s5StdDev  float  TMS 

Panel Standard Deviation Gauge 6 s6StdDev  float  TMS 

Panel Standard Deviation Gauge 7 s7StdDev  float  TMS 

Panel Weight sWeight  float  TMS 

Panel Density sDensity  float  TMS 

Panel Maximum Thickness All Gauges sMaxThk  float  TMS 

Panel Minimum Thickness All Gauges sMinThk  float  TMS 

Panel Maximum Thickness Gauge 1 sMaxThk1  float  TMS 

Panel Maximum Thickness Gauge 2 sMaxThk2  float  TMS 

Panel Maximum Thickness Gauge 3 sMaxThk3  float  TMS 

Panel Maximum Thickness Gauge 4 sMaxThk4  float  TMS 
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LastPanel (Continued)    

Panel Maximum Thickness Gauge 5 sMaxThk5  float  TMS 

Panel Maximum Thickness Gauge 6 sMaxThk6  float  TMS 

Panel Maximum Thickness Gauge 7 sMaxThk7  float  TMS 

Panel Minimum Thickness Gauge 1 sMinThk1 float  TMS 

Panel Minimum Thickness Gauge 2 sMinThk2 float  TMS 

Panel Minimum Thickness Gauge 3 sMinThk3 float  TMS 

Panel Minimum Thickness Gauge 4 sMinThk4 float  TMS 

Panel Minimum Thickness Gauge 5 sMinThk5 float  TMS 

Panel Minimum Thickness Gauge 6 sMinThk6 float  TMS 

Panel Minimum Thickness Gauge 7 sMinThk7 float  TMS 

Average Thickness 1st half of panel sAveThkFr float  TMS 

Average Thickness 2nd half of panel sAveThkRe float  TMS 

Number of Blows in Zone 1 sBmsZone1 short BMS 

Number of Blows in Zone 2 sBmsZone2 short BMS 

Number of Blows in Zone 3 sBmsZone3 short BMS 

Number of Blows in Zone 4 sBmsZone4 short BMS 

Number of Blows in Zone 5 sBmsZone5 short BMS 

Number of Blows in Zone 6 sBmsZone6 short BMS 

Number of Blows in Zone 7 sBmsZone7 short BMS 

Number of Blows in Zone 8 sBmsZone8 short BMS 

Number of Blows in Zone 9 sBmsZone9 short BMS 

Panel ID (number) sPanelID short Both 

Panel Opening Number sOpening short Both 

Press Load Number within Product sPress short Both 

    

LastPress    

Press Average Thickness Gauge 1 sPressAveThk1 float TMS 

Press Average Thickness Gauge 2 sPressAveThk2 float TMS 

Press Average Thickness Gauge 3 sPressAveThk3 float TMS 

Press Average Thickness Gauge 4 sPressAveThk4 float TMS 

Press Average Thickness Gauge 5 sPressAveThk5 float TMS 

Press Average Thickness Gauge 6 sPressAveThk6 float TMS 

Press Average Thickness Gauge 7 sPressAveThk7 float TMS 

Press Standard Deviation Gauge 1 sPressStdDev1 float TMS 

Press Standard Deviation Gauge 2 sPressStdDev2 float TMS 

Press Standard Deviation Gauge 3 sPressStdDev3 float TMS 

Press Standard Deviation Gauge 4 sPressStdDev4 float TMS 

Press Standard Deviation Gauge 5 sPressStdDev5 float TMS 

Press Standard Deviation Gauge 6 sPressStdDev6 float TMS 

Press Standard Deviation Gauge 7 sPressStdDev7 float TMS 

Average Weight for Press sPres-AveWeight float TMS 
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Miscellaneous MM    

BMS Chanel Count Message & Password Error 

Msg 

sLogo string BMS 

Product sProduct string Both 

Blow Size sBlow_Size short BMS 

Blow Level sBlow_Level short BMS 

Password for Blow Level Change sBlowPassword string BMS 

 

BMS – Defined if customer system installed with BMS. 

TMS – Defined if customer system installed with TMS. 

Both – Always defined. 

 

Float – Passed as a floating point number. 

Short – Passed as a short (16 bit) binary integer. 

String – Passed as a character string. 

 


